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Instruction Manual

Content of this Instruction Manual

EMU is used for EOS MOVIE Utility.

In this manual, the windows used in the
examples are from Windows 8.1.

Camera model is displayed as an icon.
Example:EOS-1IDC » [ 1DC
0} displays the relevant camera model.

» indicates the selection procedure of the
menu.

(Example: [File] menu » [Exit].)

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

p.** indicates a reference page.
Click to move to the relevant page.

. Marks information that should be read
before use.

: Marks additional information you may find
helpful.

Switching Between Pages
Click on arrows on the bottom right of the screen.

@ . next page
€) : previous page
: return to a page you had previously

displayed
Click on the headings on the right side of the
screen to switch to the contents page of that
heading. Also, click the item you want to read
about on the table of contents to move to the
relevant page.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction System Requirements

Introduction

EOS MOVIE Utility (hereinafter, “EMU”) is software for playing, merging Refer to the Canon Web site for information on the system

and saving MOV format movies shot on the supported camera. requirements.
Main Features of EMU i Contents
With EMU, you can smoothly play movie files shot on the supported Su p p O rted MOVI €s
camera. You can also use View Assist for playing movies shot on an Movie type Extension
EOS-1D C with Canon Log gamma. In addition, you can - " Preparation
consecutively play back multiple 4 GB movie files created from one MOV format movies shot on the supported camera MOV
clip (shot successively), merge them into a single file, and save it *Video snapshot albums are not supported.
(EOS-1D C and EOS 7D Mark 1l only). Extracting still images is also Video files in MP4 format are not supported.
possible. Basic

Screen
What is Canon Log gamma? Supported Camera
This function allows rich gradation expression from dark points to
bright points, applying a wide dynamic range. It maximizes the EOS-1DC EOS-1D X EOS 5D Mark Il Playing Back
excellent capability of CMOS sensor. EOS 6D EOS 7D Mark Il EOS 70D
What is a movie clip? o
. . . . L . Confirming File

A movie recorded in a single shooting operation is called a movie Information
clip.

(D Do not remove the memory card from the card reader during Saving
access.

Exiting EMU
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Installing the Software

(D When installing this software, an administrator-level privilege is
required.

Double-click the compressed EMU file (.zip format)
downloaded from the Canon Web site to open it.

Double-click “emuw120.exe” in the folder.

Follow on-screen instructions for installation.

Starting up EMU

Double-click the desktop shortcut.

ﬁ Double-click
&

EUSITTOVIE
Wislliay

EMU starts up and the main window appears.

v

& EOS MOVIE Utility - olEl|
il

- Timecode 00:00:00:00 Duration 00:00:00:00 Playback Rate x 1.0

=
LUT [ 200% H»ﬁ

|§| Starting up multiple EMU at the same time is not possible.
If the screen’s font size is set to other than 96dpi, characters in
dialog boxes or buttons may not be correctly displayed.
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Basic Screen

Main Window

You can view, play back, stop movie clips, save still images or merge and save movie files in the main window.

EOS MOVIE Utility

File View Marker Tools ﬂelp‘

0wt O 200% -
)

\

Timecode 01:22:26:10

F Y N>F||aF

dl

Duration 00:03:15:04

>

Playback Rate x 1.0

A A« R A=

Menu
Menu to execute all functions.

Preview area
Displays a clip to be played back.

Control area

For operations such as controlling
playback, capturing still images,
merging and saving movie files.
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Playing Back a Movie Clip

The method for playing back a movie clip is described here.
It is recommended that you first copy the folder on the memory card in
which the movie clips are saved to your computer using a card reader.

Movie Clip Playback

In the main window, select the [File] menu » [Select
a clip folder].
The [Browse For Folder] dialog box appears.

Select the folder where the movie clip to play is
saved, and then click the [OK] button.

Browse For Folder “

Specify DCIM folder.

Bl Deskiop
A o000
48 This PC

- B Videos
4 Local Disk (C)
» i DVD Drive (D)
4 oy EOS_DIGITAL (E:)
MISC

[ Libraries

- €l Network

> 000K

The [Clip list] dialog box appears.

You can also select folders on the memory card directly by
inserting the memory card in the card reader and then connect it
to the computer.

You cannot directly select folders on the camera’s memory card
by connecting the camera to the computer.

(D Movie files shot on a camera are recorded on the memory card with

the folder structure shown below.

| DCIM '| 100EOSxX

or
100CANON

1 MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

] 101EOSxx
or
101CANON

1 MVI_xxxx. MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

I | 102EOSxx
or
102CANON

With this software, if the above folder structure is not maintained, it
may not be possible to play back the movie clips properly. When
playing back movie clips, make sure the above folder structure is
maintained and the DCIM folder at the upper layer of the folder
structure is selected. Even when the folder structure is maintained,
be aware that it may not be possible to play back the clips properly if
the name of the selected folder, originally [DCIM], has been

| MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

changed to another name.
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Select the movie clip to be played back in the [Clip
list] dialog box.
Clip list “

Clip o=

MVI_0002
MVI_0003
MVI_0004
MVI_0005
MVI_0008
MVI_000%
MVI_0010

< >

The image of the movie clip appears in the main window.

In the main window, click the [ [_» 1] button.
=—T . |

L] EDS MOVIE Utility
e Yoew Maker Took Help

= . . = 5 ==
- Timecods 01:20:48:00 Duration 00:03:15:04 Playback Rate x 1.0
=
DT 0200 « '““‘I_E
G Ve verar | @ > Ii» A b AE 7 =

The movie clip is played.

For operations during playback, see “Playback Control” on the
right of this page, and p.8 to p.13 (“Adjusting Volume” to
“Switching the Movie Display Size”).

(D Consecutive playback of multiple 4 GB movie files created from one
clip (shot successively) is only supported for [ 1D C | and (7D Mk I} .

Playback Control

During playback, buttons allow you to perform the following operations.

In point marker (display only)
Out point marker (display only)

R

Introduction

e

Contents

—

Preparation

—_—

Basic
Screen

N Timecode 01:22:2t:10 Duration 01:03:15:04 Playback Rate x 1.0 A i | E=
——
8 J f 2D | T
Ot Ol 2000 EE‘%
- Y LP ] Dapr| [2r I<II |> I>I III> 00+ 4] RE =i
Play/Stop Next frame
Previous Adjust playback speed
frame
Jump to the frame at the Out point
Play a specified range

Jump to the frame at the In point

Set the Out point (ending point)*

Set the In point (starting point)*

*These buttons specify the In (start) and Out (end) points when specifying
a playback range (p.10) or saving multiple still images (p.18).

5

In the [Clip list] dialog box, you can switch between movie clips
with the <T><1> keys on the keyboard or by clicking the mouse.
You can also double-click a movie clip name in the [Clip list]
dialog box to play back a movie clip.

Even if you close the [Clip list] dialog box, the content of the list is
saved. If you click the [ 5= ] (Clip list) button in the control area or
select [Clip list] from the [View] menu, the [Clip list] reappears.

—_—
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Adjusting Volume

You can adjust volume during playback with the volume slider.

Drag the volume slider left or right.

R Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 A
——

=
0

(b Z]
Ut O 200% v

it |

MLARA A N4 dl > > 1> LR LIRE I =

Volume slider
Mute button

To temporarily turn audio off, click the [ ] (mute) button.

Changing the Playback Speed

You can change the movie playback speed.

Click the [[ > |] button while a movie is played.

Playback speed Current
adjustment button playback speed
i R Timecode 01:22:26:10 Duration 00:03:15:p4 Playback Rlatex 1.0 P illE=
0
K A =
OwWTO 200% v H*@
o NP Y T T l > > » A A« 2R (AE =

Each time you click the [[ > ]] button, the playback speed

 EEEEE—

Introduction

changes as follows.
Movie clip frame | Playback Frame rate after changing Contents
rate speed playback speed
59.94p x1.0 59.94p
Preparation
x0.5 29.97p
x0.4 23.98p
Basic
50p x1.0 50p Screen
x0.5 25p
Other than above* | x1.0 Movie clip frame rate Playing Back

* You cannot click the playback speed adjustment button.

|§| Audio is not played during slow playback (when playback speed is
x0.5 or x0.4).

Moving the Playback Position

You can move the playback position with the frame position slider.

Drag the frame position slider left or right while a clip
Is played or stopped.

Frame position slider

F ~ Timecode 01:22:26:10 Duration 0§:03:15:04 Playback Rate x 1.0 P i|lB=
=
[ A

=]
HILUT I (200% ~ H*%
) ARLARA L Nhia ARCLATRI. > > 1> A0 40 A= =
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Introduction

- Marker list “
Setting Markers e —
Mumber Timecode
Markers can be used for tasks such as specifying the playback start
. 2 0L:22:34:22 Contents
position. Up to 5 markers can be set. 5 01:22:43:23
4 01:22:50:09
Drag the frame position slider left or right and click
the [ (a2 ] (Add marker) button at the position where e peee e — Preparation
you want to set a marker. —
i R Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 P illBs * SeIeCt a number from the IISt and CIICk the [Move] bUtton to
= === move the position of the selected marker, and the frame at that Basic
5 : : = position is displayed. Effective when only one number is Screen
OwT O 200% v H‘@
] N7 v [y [ > > G)" G = selected. —
The marker is set * Select a number from the list and click the [Delete] button to
. ' _ delete the selected maker. Playing Back
. Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 A0 i B 4 YOU can save the frames at a” the marker pOSitionS on the ||St
g 4 . . G) . . = as still images. (p.19)
oo o S R ] T | T T (8] ] R 6 Q'ﬁ ® You can set a marker by clicking the [ |8 ] (Add marker) button Confirming File

Up to 5 markers can be set.
Click the [ A« ] or [ *A ] button to select the next marker in the
arrow direction and display the frame at that position.
If there is no other marker between the selected marker and the Saving
start of the clip, the first frame in the clip is selected and
displayed. If there is no other marker between the selected
marker and the end of the clip, the last frame in the clip is .

. Exiting EMU
selected and displayed.
Click the [ 8= ] (Marker list) button to display the list of markers.
It displays a numbered list of markers and time codes in order
from the beginning of the clip. Reference

Q0
)

|§| The marker settings in the selected clip are saved automatically, ~—
and the settings continue to be effective the next time you work with
the clip in EMU.

|

|

[



Playing a Specified Range

You can play back only a specified range of a selected clip.

Follow steps 1to 3in “Movie Clip Playback” (p.6).

Drag the frame position slider left or right until the
frame where you want to start playback appears,
then click the In point button.

Playback Rate x 1.0 A0 i H=
——

' N Timecode 01:21:35:24 Duration 00:03:15:04
&
I A

|
OwT O 200% v H"@
0] OV e 74P dl > > 1> A e 20 A= (=

| |

In point button In point marker

The In point marker is now displayed, and the starting point for
playback is set.

You can click this button even during movie playback to specify
the In point.

Once you have specified the In point, you can jump to the frame
at the In point by clicking the [[¢]] (move to IN point) button. If no
In point has been set, clicking this button jumps to the first frame.
You can click the [ [+ ] (move to IN point) button even during
movie playback.

Drag the frame position slider left or right until the
frame where you want to stop playback appears,
then click the Out point button.

N Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 Y| il B=s
——
- Al
s Z1 Al ‘?% E:a
0wt 200% « H"ﬁ
o) A o‘* i ARGid dl > I» 1> A |he +0 A= =

Out point button Out point marker

The Out point marker is now displayed, and the ending point for
playback is set.

You can click this button even during movie playback to specify
the Out point.

Once you have specified the Out point, you can jump to the
frame at the Out point by clicking the [ [*f] ] (move to OUT point)
button. If no Out point has been set, clicking this button jumps to
the last frame. You can click the [[*] ] (move to OUT point) button
even during movie playback.

The maximum range between In and Out points is one hour.
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Click the [ »r ] (Play IN-OUT) button.

Playing Back Movies Shot with Canon Log
N Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 A il lB=

. \ , = Gamma set to [On]

| ——
DT L 200% ~ H’ﬁ n l 1D C
1 ‘«-@»V dll » > 1> (I RE (=

. Movies shot on an EOS-1D C with Canon Log gamma (p.2) set to [On]

Contents

The range of the clip between the IN point and the Out point is will look dark and have low contrast by default. If you apply a look-up _
played back. table (LUT) and play back the clip, you can check the clip with an image Preparation
The In and Out points can be removed from [Marker] on the main close to normal display.
screen menu.
Select [Delete IN point], [Delete OUT point], or [Delete both IN Checkmark the [LUT] checkbox. Basic
point and OUT point] as required. Screen
r N Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 A illE=
When no In or Out point has been set, the range played back is -
= 2] D
as fOIIOWS. UTD 200% v a‘ﬁ :
« When no In point has been set, the playback range extends E | AAL) i > b L Iv | (8]l o] [ = Playing Back
from the first frame of the clip to the Out point. [LUT] checkbox is not available if movies were shot with Canon
* When no Out point has been set, the playback range extends Log gamma set to [Off].

from the In point to the last frame of the clip.
* When no In point and no Out point have been set, the playback
range is the entire clip.

. Confirming File
Play back the selected movie. s

Perform the operations described in “Movie Clip Playback” (p.6).
The LUT is applied and the movie is played back.

[

Saving
|§| You can check or uncheck the LUT checkbox with the <B> key on
the board.
Exiting EMU
Reference

Q0
O

|§| The In and Out point settings in the selected clip are saved
automatically, and the settings continue to be effective the next time

you work with the clip in EMU. 1



Playing Back in Full Screen

Play back a movie.
Follow operations in “Movie Clip Playback” (p.6).

In the main window, select the [View] menu » [Full
Screen].
The movie played back is displayed in full screen.
You can also double-click the preview area to display the movie
in full screen.
To cancel full screen display, press the <Esc> key or double-click
the mouse.

R
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Switching the Movie Display Size

You can apply either [Fit to window] mode, [100%] mode, or [200%]
mode as the method for displaying a movie in the preview area.

Enlarged position in guide area

Select the [View] menu P [Fit to window]/[Change
maghnification].

When you select [Change magnification], choose
[100%] or [200%)] in the magnification change list box
in the control area.

LILUT ™ 1009 v

Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 A il|lE=
——

]
ERE

MLAN SRR AR || > > 1> A+ +0 RE

200%
The image is displayed in the preview area with the selected
display mode.
In [Fit to window] mode, the image is displayed completely within
the preview area.
In [100%] mode, the image is enlarged to 100% (actual pixel
size) and displayed in the preview area.
In [200%] mode, the image is enlarged to 200% and displayed in
the preview area.
To change the display position of an image in [100%] mode or
[200%] mode, drag the image in the preview area.
If you remove the checkmark from the [100%] or [200%]
checkbox in the magnification change list box, the display will
change to [Fit to window] mode.
In [100%] or [200%] mode, you can use the guide area, which
represents the entire image, to check the position of the image
within the preview area.
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Confirming the Movie File Information

You can display and confirm shooting information for movie clips.

Shooting Information

Click the [ &= ] (Clip list) button in the control menu
on the main screen.

N Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 ] 5
&
[ | D E:E
DT O 200% ~ H»g
) N[ [yl [ror] | > > > | [a ae[+a [a= =

The [Clip list] dialog box appears.

Note that this function is available after you select a folder in
which the movie files to be confirmed are saved. If no folder is
selected, follow steps 1 to 2 in “Movie Clip Playback” (p.6) to
select a folder.

In the [Clip list] dialog box, select a movie clip to
display its shooting information.

Click the [ i ] (Shooting information) button in the
control menu on the main screen.

Item

File Size

Movie splitting flag
Compression format
Movie quality
Camera Model
Camera Body Mo,
Shooting Date,/Time
Image Size

Frame Rate

Time Code Format
Audio Channe!
Audio Rate

Audio Format

Lens

Focal Length

Movie exposure
Tw({Shutter Speed)
Av{Aperture Value)
Metering Mode

150 Speed

Canon Log
Sharpness

<

Value

4.4GE

Present

MPEG-4 AVC/H. 264

Low compression(intra fra...

Canon EOS XXX
FOCOOOGGK
HHRHTRADE KX HK
19201080

59.94

Non drop frame

2¢ch

48 kHz

LPCM

EF 16-35mm f/2.8L USM
35.0mm

Marual

1/60

5.6

Center-Weighted Average...

400
On
0

A

5]

Timecode 01:22:26:10

Duration 00:03:15:04

-
0

s 2

DILUT L 200% ~

)

Y| F|[Ye

Aiad

+F

4l

>

>

1>

Playback Rate x 1.0

LR LS

\&H

]

The shooting information is displayed in the [Shooting
Information] window.
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Saving Still Images

Still images can be extracted and saved from the current movie clip.

Introduction
Under [Kind of file], select the desired file format.

Still Image Capture Settings

First, complete the settings for how still images are saved from movies.

In the main window, select the [File] menu » [Still
Image Capture Settings].

The [Still Image Capture Settings] dialog box appears.
On the [General] tab, complete the settings as
necessary.

Still Image Capture Settings “
General | File name
Image format

Kind of file:
JPEG W

Image quality:

Capture as-s when re-encoding is not necessary

Folder for Exported Files

[+] Automatically generate a subfolder for each dip switch

0K Cancel

Select [TIFF] to save images as uncompressed 8-bit RGB TIFFs.

By default, [JPEG] saves images at the highest setting in [Image

quality].

When the file format specified in [Kind of file] under [Image

format] is set to [JPEG] and [Capture as-is when re-encoding is

not necessary] is checkmarked, still images will be extracted

from movies without modifications for the following movies.

Faster processing will be achieved.

* 4K movies shot with Canon Log gamma set to [Off]

« 4K movies shot with Canon Log gamma set to [On] without
applying an LUT

To specify the destination, click the [ [-| ] button under [Folder for

Exported Files] and choose the location in the [Browse For

Folder] dialog box.

To save still images in a new subfolder, checkmark

[Automatically generate a subfolder for each clip switch]. This

option prevents files from being renamed if the destination folder

already contains files with the same name.

Contents

Preparation

Basic
Screen

Playing Back

Confirming File
Information

Saving

Exiting EMU

Reference

QO
©

15




 EEEEE—

Introduction

On the [File name] tab, complete the settings as To name still image files or edit existing names, checkmark
necessary and click the [OK] button. [Rgngme Files]. !n [New file name], enter a name or change the

The settings are now complete. e>.<|s.t|ng name. File names can be up to 30 characj[ers.. Note that o

still image files cannot be renamed unless this option is ontents
Still Image Capture Settings X checkmarked. In such a case, the file name will be the same with
General il name the original movie clip.
[¥]Rename Fies To append a serial number to file names that indicates the Preparation
New fiz name number of times still images have been captured from a movie

clip, checkmark [Include still image capture count]. In [Still image
capture count], enter the first serial number, in the range 0— Basic
99999. Screen
To reset the serial number in [Still image capture count] when you
select another movie clip, checkmark [Reset when selected as
clip]. Playing Back
To append the time code to the end of file names, select [Time
code] under [Image sequence settings]. To append a serial
number, select [Initial Value for Consecutive Numbers]. Confirming File
Information

CINE

Indude still image capture count

Still image capture count

00005

Reset when selected as dip

Image sequence settings

(®) Time code

() Initial Value for Consecutive Numbers

Ex.: CIMNE_00000_HHMMSSFF, PG
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Still Image Saving Controls

When you save still images, you can perform the following operation
with buttons.

In point marker (display only) Save a still image

Out point marker (display only) Save multiple

Marker (display only) still images
. N Timecode 01:22:26:10 -Duration 00:03:15:04 Playback Rate x 1.0 | A1 J illB=
1 I
h A L V’V’% ﬁ ﬁ
OLWT O 2000% +
m |7 | [we| [wr [arl [« » > TS i) e

A« 0 A= T
| I I

Set the marker L|J

Move the marker

Display the marker list

Save the frames at all the
marker positions as still
images

Jump to the frame at
the Out point

Jump to the frame at
the In point

Set the Out point (ending point)*

Set the In point (starting point)*

*These buttons specify the In (start) and Out (end) points when specifying
a playback range (p.10) or saving multiple still images (p.18).

|§| [ 1D C J: To save still images with the LUT applied, checkmark
[LUT] checkbox.
Focal length, shutter speed, ISO speed, white balance and GPS
information in the shooting information appended to the image
are values when the movie shooting started. However, the date
and time when the still image was actually shot will be calculated
and appended as shooting date and time.

Saving Individual Still Images

In the main window, select the [View] menu »
[Clip list].

The [Clip list] dialog box appears.
Select a movie clip in the [Clip list] dialog box.

Drag the frame position slider left or right to display
the frame to save.

R Timecode 01:20:48:00

&
i a4 @ ]
OWT O 200% v H‘@
) ARLA DR s REl4 4l > > 1.2 A he +A A= (=

Duration 00:03:15:04 Playback Rate x 1.0 ] illB=
—

Click the Save individual still image button.

F ~ Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 P il|lE=
&
0
[ A

=
OLUT O 200% ~ H*g
) MILANC LSRRI > > 1> A [he +0 AE =
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A still image is saved following the settings in the [Still Image
Capture Settings] dialog box.
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Saving Multiple Still Images

By specifying a segment in the current movie clip, you can save all
frames within the segment as still images.

In the main window, select the [View] menu »
[Clip list].

The [Clip list] dialog box appears.
Select a movie clip in the [Clip list] dialog box.

Drag the frame position slider left or right to display
the starting frame, and then click the In point button
when a frame from which you want to start saving
appears.

N Timecode 01:21:35:24 Duration 00:03:15:04 Playback Rate x 1.0 P il Bs=

——
&

& 4

=
OwWwT O 200% v | H‘@
-0 or e 74 dl > > 1> A A B0 (AE (=

| |

In point button In point marker

The In point marker is now displayed, and the starting point for
still images to save is set.

You can also click this button during movie playback to specify
the In point.

Once you have specified the In point, you can jump to the frame
at the In point by clicking the [[¥¢]] (move to IN point) button. If no
In point has been set, clicking this button jumps to the first frame.
You can also click the [ [1¢] ] (move to IN point) button during
movie playback.

Drag the frame position slider left or right to display
the ending frame, and then click the Out point
button.

N Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 Y| il B=s
——
- Al
s Z1 Al ‘:% E:a
0wt 200% « H"ﬁ
o) A O‘* i ARGid dl > I» 1> A |he +0 A= =

Out point button Out point marker

The Out point marker is now displayed, and the ending point for
still images to save is set.

You can also click this button during movie playback to specify
the Out point.

Once you have specified the Out point, you can jump to the
frame at the Out point by clicking the [ [*f] ] (move to OUT point)
button. If no Out point has been set, clicking this button jumps to
the last frame. You can also click the [ [*f] ] (move to OUT point)
button during movie playback.

The maximum range between In and Out points is one hour.
The In and Out points can be removed from [Marker] on the main
screen menu.

Select [Delete IN point], [Delete OUT point], or [Delete both IN
point and OUT point] as required.
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Click the Save multiple still images button.

6 N Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 A1 illE=
——
- Al 4
o ﬂ =) 5
Ot O|200% v H*ﬁ
” N [r] e er ] > [ | (][] [+a] [0= =

Save multiple still images button

Still images are saved following the settings in the [Still Image
Capture Settings] dialog box. All frames between the In and Out
points are saved as still images.

You can also click this button during movie playback to save still
images. In this case, playback is paused during capture.

|§| The In and Out point settings in the selected clip are saved

automatically, and the settings continue to be effective the next time
you work with the clip in EMU.

Saving All the Frames where Markers are Set as Still Images
Click the [ ] button.

d ~ Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 A i ||B=
——
s
- - ' ' ' ' ' iE
OWwT O 100% v = H»@
) AN LA A AR | > > 1> EREE o L

All the frames specified with the markers are saved as still
images using the settings made in the [Still Image Capture
Settings] window.

@ You can also save all the specified frames with markers in the
procedures as below.

Click the [ 2= ] (Marker list) button in the control area
to display the marker list.

"y Click the [Capture all images] button in the marker
list.
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Merging and Saving Movie Files

3 :oc ) (7omkil)
When you shoot movies with the supported camera, the movie file will

be split by 4 GB and multiple movie files will be created automatically,
even for a single shooting. You can merge these multiple files and save
them as a single file with this function. Note that this function only
supports movies shot with [ 1D C | or (7D Mk1I] .

Checking the Movie Files in a Movie Clip

In EMU, the split movie files will be displayed as a single movie clip. You
can check the structure of a movie clip and see the movie files that
consist the movie clip in the procedures as below.

In the main window, select the [View] menu P [Clip
list].

The [Clip list] dialog box appears.

To use this function, you must first select the folder in which the

movie clips to check are saved. If a folder is not selected, follow
steps 1 to 2 of “Movie Clip Playback” (p.6) to select a folder.

In the [Clip list] dialog box, select the movie clip
whose structure you want to check, right-click with
the mouse, and select [Show structure of the clip]
from the menu that appears.

Clip list “

Clip name

MVI_0001
MVI_0002
MVI_0003
MVI_0004

MVI_0008 Show structure of the clip)
MVI_0009
| | MVI_0010

Merge split files...

The [Structure of Clip] dialog box appears.

Structure of Clip “

thp name: MVI_0005

Fi \DCIM\moEosm\Mw_ooos.Mov)

F:\DCIM | 100E05 1D \MVI_DO06.MOV
F:\DCIM\100EOS1D \MVI_0007.MOV

Close

Movie file names are displayed
in several lines for a movie clip
made up of split movie files.
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Introduction

Click the [ [.. ] ] button for [Folder for Files to be

I\S/I'erglmlg:'lsp“t Movie Files and Saving as a Merged] and then select the folder in which the
ingie rlie ie fi
g movie files to be merged are saved. Contents
You can merge multiple split movie files composing a movie clip and Merge Files
save them as a single file. The original movie files are kept as they are
in the folder they were originally saved. S
Merging All the Split Movie Files in the Folder All the movie files saved in the selected folder will be merged.
and Saving as a Single File Basic
Click the Merge split files button in the main window. -
6 N Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 A illE=
: = Playing Back
CLUT O 200% v EE"H D
] Y r v verllar ol > > » s =
o | Confirming File
Merge split files button Information

{

The [Merge Files] dialog box appears.
In the main window, you can also select the [Tools] menu »

[Merge split files] to display the [Merge Files] dialog box. Saving
NergeFies ]

-

Exiting EMU
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(D Movie files shot on a camera are recorded on the memory card with

the folder structure shown below.

| DCIM 'I 100EOSXX 1 MvI_xxxx.MOV

or
100CANON

MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

] 101EOSxx
or
101CANON

1 MVI_xxox. MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

I | 102EOSxx
or
102CANON

| MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

With this software, if the above folder structure is not maintained, it
may not be possible to merge the split movie files properly. When
performing “Merge all the split movie files in the folder and save as a
single file” operation, make sure the above folder structure is
maintained and the DCIM folder at the upper layer of the folder
structure is selected. Even when the folder structure is maintained,
be aware that it may not be possible to merge the movie files
properly if the name of the selected folder, originally [DCIM], has
been changed to another name.

Click the [ [..] ] button for [Folder for Exported Files]
and then select the folder for saving the merged
movie file.

Folder for Files to be Merged

L-]

Automatically Generate Subfolders

Click the [Start] button.

Folder for Exported Files

Remember Consecutive Numbering

saved Files

[l indude Unsplit Clips

Start Cancel

7Merang an?saviné starts.
A message appears when merging and saving are complete.

If you checkmark [Automatically Generate Subfolders], a
subfolder is created in the folder for the merged movie file
selected in step 3, then the merged movie file is saved there. A
file can be saved without changing its file name even if another
file with the same file name is already in the folder.

If you checkmark [Rename Files], you can change the file name
of the merged movie file when saving it.

To create file names with consecutive numbering, enter the initial
value in the [Initial Value for Consecutive Numbers] box. You can
enter an initial value that is up to 5 digits. Checkmark [Remember
Consecutive Numbering] to allow consecutive numbering to
continue even after closing the [Merge Files] dialog box and
opening it again to merge and save movie files.

If you checkmark [Include Unsplit Clips], movie files not split but
saved in the folder selected in step 2 are copied to the folder for
saving the merged file together.
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Merging Split Movie Files for a Single Movie
Clip and Saving as a Single File

In the main window, select the [View] menu P [Clip
list].
The [Clip list] dialog box appears.
Note that this function is available after you select a folder in
which the movie files to be merged are saved. If no folder is
selected, follow steps 1 to 2 of “Movie Clip Playback” (p.6) to
select a folder.

In the [Clip list] dialog box, select the movie clip to
be merged, then right-click and select [Merge split
files] from the menu that appears.

The [Merge Files] dialog box appears.

Click the [ [-.]] button for [Folder for Exported Files]

and then select the folder for saving the merged
movie file.

Click the [Start] button.

Merging and saving starts.
A message appears when merging and saving are complete.

Exiting EMU
In the main window, select the [File] menu » [EXit].
EMU exits.
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Reference

Troubleshooting

If EMU is not operating correctly, refer to the information below.

EMU does not work

EMU does not operate properly on a computer which does not meet
the system requirements. Use EMU on a computer compatible with
system requirements (p.2).

Even if your computer has the RAM capacity (memory) that meets the
system requirements, if other applications are running at the same
time as EMU, you may not have sufficient RAM (memory). Exit
applications other than EMU.

Text and buttons are not displayed properly

If the font size for the screen is set to other than 100% (96 dpi), text
and buttons may not be correctly displayed. Set the font size for the
screen to 100% in the display settings for Windows.
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Error Messages

If an error message appears, refer to the information below.

Message

Cause and solution

The merge process has
been failed.

Check that there is a save destination
folder. If the save destination folder is on an
external storage device, check that it is
connected to the computer correctly.

Cannot create a folder
at the selected
destination.

The memory card specified for the save
destination is write-protected. Insert a
writable memory card.

Please enter
consecutive numbers.

No consecutive numbering is entered.
Enter an initial value for consecutive
numbering when there are several movie
clips with movie files to be merged.

The size of the file you
are saving is not
supported on the
destination file system.

The file system specified for the save
destination does not support the size of the
file being saved. Change the save
destination.

Sufficient consecutive
numbers are not
provided for the files.

Consecutive numbering for file names
exceeds 99999. Change the value entered
for numbering or the file save destination.

EOS MOVIE Utility has
already started by other
user.

Log into the user account in Windows in
which EOS MOVIE Utility is running, exit
EOS MOVIE Utility, and start it up again.

4 GB or larger files may
not be supported on the
file system of output
destination. Do you
want to continue?

The merged movie file may not be saved to
the drive where the save destination folder
is located. Check that the file system
specified for the save destination drive
supports files of 4 GB or larger.

Could not merge
because there was not
enough available space.

There is insufficient space on the drive
where the save destination folder is
located. Create enough space or change
the save destination, and then repeat the
merge process.
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Keyboard Controls
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Controls focused on in main window

et GG DR D Volume slider Frame position slider
Space - Play/Stop
Shift+Space - Play range between In and Out points
- Raise volume Next frame
- Lower volume Previous frame
Shift+— Operation set with OS Raise volume Jump to Out point for multiple still images
Shift++ Lower volume Jump to In point for multiple still images
Shifte1 B Select ne;(f) rsrilt?(;lr(]earmbdegv;/:r?n current
Shift+l A Select ne;togggie; rl})gt(\;\;]eden current
Home - Jump to first frame
End - Jump to last frame
B Enable/Disable look-up table [LUT]
L Play
Shiftel Play range b_etween In and Out points _

When pressed in playback state: play again
K Stop
S Adjust playback speed
\% Switch display size
F Full screen display
Ctrl+S Save a still image
Ctri+T Save multiple still images
Ctrl+Alt+M Save all the frames where markers are set as still images
D Merge all split files in folder and save
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Uninstalling the Software

Before starting the software uninstallation, exit all programs you are
using.

Log in under the Administrator privileges when uninstalling the
software.

Uninstall the software according to the OS software uninstalling
method.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Also, reinstalling the software
without first restarting your computer is likely to result in computer
malfunctions.
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About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademarks

Microsoft and Windows are trademarks or registered trademarks of
Microsoft Corporation in the United States and/or other countries.
All other trademarks are the property of their respective owners.
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